
   

 
 
 
 
 

LineScale™ Plug-In for Adobe Acrobat 
Congratulations on your purchase of 
the LineScale™ plug-in for Adobe 
Acrobat.  This plug-in provides 
sophisticated distance and area 
measurement capabilities to users 
of Portable Document Format (PDF) 
files.   

Powerful features include: 

• Easy to use, intuitive interface 

• Precision “snapping” to points in 
vector graphic drawings  

• Segment length, total length, 
and area calculations 

• User-definable scale factors 

• Metric / English unit conversions 

• Continuous display in toolbar 
window 

• Fractional inch display 

• Orthogonal cursor constraints 

• Works with Adobe Acrobat and 
Microsoft Internet Explorer 
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System requirements 
• Microsoft Windows XP 

• Adobe Acrobat version 7 or 8 (Standard or Professional) 

• Microsoft Internet Explorer (required for measuring PDF drawings on the web) 
 

 

Installation setup 
The LineScale plug-in will install automatically for Acrobat.  Double-click on the file named 
LINESCALE_V180.EXE to begin installation. 

 
Evaluation mode 
The LineScale plug-in is initially installed in evaluation mode.  In this mode all functions of the 
plug-in are available, but you will be able to use the plug-in for only three (3) days.  After the 
time limit has expired the plug-in will be inoperative until it is licensed. 

While in evaluation mode, a dialog box will be displayed whenever Acrobat is started up.  You 
can work in evaluation mode by clicking OK.  By clicking on the Buy Now! Button, you will be 
transferred to the LineType Software, Inc. website to purchase a license key.  After your credit 
card has been processed, a license key will be emailed to you (usually within one minute). 

 

 

We recommend that you save the 
setup file and your license key in case 
LineScale ever needs to be installed on 
your system again. 
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License key 
License keys for the LineScale plug-in are created for a specific name and hardware fingerprint.  
The name is the person to whom the key is sold.  The hardware fingerprint is a unique number 
that identifies the computer on which the key can be installed. 

Be sure that the computer on which you plan to use the LineScale plug-in is the same computer 
on which you have installed the evaluation copy, and the one you use to purchase the key.  A 
key for one computer cannot be used on a different computer, because they will have different 
hardware fingerprints. 

When purchasing a key from the LineType Software, Inc. website, you will be required to enter 
the hardware fingerprint from your system.  If you enter the website by clicking on the Buy 
Now! button, the hardware fingerprint will automatically be entered in the appropriate field.  If 
the website is opened by some other means, then you will need to enter the hardware 
fingerprint manually (or by using copy and paste). 

See the box to the right for helpful information about entering the key code. 

  

To enter the key code in the license 
key dialog box: 

• Select the key code in the email 
that you received when it was 
purchased. 

• Choose Copy from the right-click 
menu 

• In the License Key dialog box, click 
the mouse inside the key code 
window and choose Paste from 
the right-click menu. 

 

Uninstalling LineScale 
Because the LineScale plug-in may be installed for more than one Adobe product (it may be 
installed for different versions of Acrobat on the same computer, for instance) you must 
manually remove the plug-in from the plug-ins folder for each Adobe product. 

• Open the plug_ins folder for the Adobe product.  For Acrobat 8, for 
instance, this would be: 

C:\Program Files\Adobe\Acrobat 8.0\Acrobat\plug_ins 

 

• Delete the LineScale.API file. 

• Repeat for any other Adobe products in which the plug-in was installed. 

 

If at any time you wish to re-install the plug-in, just follow the instructions for installation.  Your 
license key is not uninstalled when you uninstall the plug-in, so the license key will still be there 
when you re-install the plug-in. 

 



Using LineScale LineScale Plug-in Help 

  

4 

 

LineScale tool icon 

The LineScale tool is activated by clicking on its tool icon:   

The tool icon is located in the toolbar.  When the tool icon is selected, the LineScale window 
appears and the plug-in is ready for use. 

• Pick a point anywhere on the document.  This is the start point. 

• As the cursor is moved around the screen, the distance from the start point to the point 
under the cursor is displayed in the LineScale window (see below).  A temporary red 
line is drawn to show the relationship between the points. 

• As more points are selected, the Segment Length from the last point to the current 
cursor position is displayed along with the Total Path Length and the Enclosed Area of 
all the points.  These measurements are all based on the scale entered in the Settings 
dialog box. 

• Hit the ESC key to stop selecting points.  The LineScale window displays measurements 
for the last point picked with the mouse. 

 

 

If the LineScale tool does not appear 
in the toolbar when Acrobat is started, 
try the following: 

• Go to Edit > Preferences > 
General 

• Click on the Options item in the 
list on the left side of the dialog 
box. 

• Un-check the Certified Plug-ins 
Only box. 

• Restart Acrobat 

LineScale window 
The LineScale window displays distance and area measurements:   
 

 
 
 The individual readouts in the window are labeled with icons: 

• Segment Length:  

• Total Path Length:  

• Enclosed Area:  

If one or more of these readouts is not needed, the appearance of the window can be 
customized in the Settings dialog box. 

If you need to copy values out of the LineScale window (for pasting into another application, for 
instance) select the value, then choose Copy from the right-click menu.  Note that Ctrl-C does 
not work in this window for copying to the clipboard. 

 

When the window is initialized it 
appears in the upper-right hand corner 
of the document.   

The window may be moved with the 
mouse, and as it is the same height as 
the Acrobat toolbars, it may be 
relocated to a spot adjacent to one of 
the toolbars.  This will keep it out of 
the main window so that it will not 
obscure any part of the document that 
you are viewing. 
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Right-click menu 
When the LineScale tool is in use, the right mouse button may be used to bring up a context 
menu to access special features.  The menu contains the following selections: 

• Temporary snap point override settings (see the description of snap points in the 
Selecting points section) 

• A Settings item to open the Settings dialog box (see the description of the Settings 
dialog box later in this document). 

• A Help item to open this help file. 

 

 

 
Shift and Caps Lock 
If Shift is held down the cursor will be temporarily constrained to horizontal and vertical 
movement only.  Turning on Caps Lock will have the same effect and may be helpful when 
horizontal and vertical constraints are needed for a longer time. 

 

 

Escape key 
Pressing the ESC key at any time during a measuring operation will stop the current 
measurement and return the LineScale tool to its “beginning” state, ready to measure again. 

The length and area display windows will indicate the last measurements made before the ESC 
key was pressed. 

 

 

Menu items 
Several features of the LineScale plug-in may also be accessed through pull-down menus in the 
main menu bar. 

• Plug-Ins > LineScale has the same effect as choosing the LineScale tool icon. 

• Help > About Third-Party Plug-Ins > LineScale opens a dialog box listing version 
and license information 
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The Settings dialog box is accessed through the right-click context menu.  The settings are explained in more detail in later sections of Help: 

The distance and units on 
the document as if it were 
printed full-size and 
measured with a ruler.  

Click this button to select 
two points on the drawing 
to use as the drawing unit 
distance.  

The “real world” units that 
correspond to the drawing 
units selected. 

When “feet” is selected as 
the display unit, check this 
box to show both feet and 
inches.  If not checked, 
distances will be displayed 
in decimal feet.

Use the slider to adjust the 
size of the selection box on 
the point snap cursor.  The 
cursor will snap to points 
that fall within the box.  A 
smaller box makes it easier 
to differentiate points that 
are close together. 

Click OK to save the 
settings and exit.  Click 
Apply to save settings and 
remain in the dialog box. 

Check this box if stray red 
lines show up on your 
screen when measuring.  
Otherwise leave it 
unchecked.  

Select the information to be 
included in the display 
window.  Eliminating  
unneeded information will 
make the display smaller. 

Select the default point 
snaps that you wish to use 
with vector graphic PDFs.  

Choose the degree of 
precision for display of 
decimal and fractional 
numbers. 

When “Display feet and 
inches” is selected, choose 
one of these options to 
indicate the format for inch 
display. 
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Scales 
In order to obtain meaningful data from the LineScale plug-in, it is necessary to choose a 
correct scale for the measurements.  The scale consists of two parts: Drawing Units and Display 
Units.   

The Drawing Units represent an actual distance on the document based on the page size and 
other information stored in the PDF file.  The Display Units are the “real world” equivalent of 
this distance. 

Most familiar scales are expressed in these terms already.  The following are all examples of 
valid scales, with the drawing units on the left and the display units on the right: 

1/8 inch = 1 foot 

1 inch = 8 feet 

1 1/2 inches = 1 foot 

2 inches = 10 miles 

1 cm = 10 km 

1 mm = 0.314961 feet 

1 point = 1 point 
 

Note that it is possible to express the same scale in different terms.  The first two items on this 
list (1/8” = 1’ and 1” = 8’) represent the same scale. 

Sometimes the scale of a drawing will be obvious – it may be written somewhere on the 
drawing, or if you created the PDF yourself you may know what the scale is. 

Other times things might not be so clear.  There may be no scale printed, or the printed scale 
may be incorrect (don’t assume that just because the drawing says 1/8” = 1’ that this is right – 
it could have been plotted incorrectly or changed by someone after being printed).   

In either case, the scale settings for the LineType plug-in include features to allow you to set a 
useable scale for almost any drawing. 

 

 

As you use the LineScale plug-in, bear 
in mind a few common-sense concerns 
about taking direct measurements 
from PDF files: 

• The measurement data you obtain 
from the LineScale plug-in is only 
as good as the precision of the 
PDF document itself.   

• If possible, verify that your scale 
settings are correct by checking a 
known quantity or a dimension 
string that is written into the 
document. 

• Check with the person who 
generated the document to 
determine if direct measurements 
are reliable, and what precision 
can be expected from the PDF 
document. 

• Scanned documents are inherently 
less accurate than vector graphics.  
Distortions may be introduced 
during scanning and this may 
affect measurements from one 
part of the drawing to another. 
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Set the Drawing Units first 
First, choose the units of measure (feet, inches, cm, etc.) that apply to the drawing.  Then enter 
the number of these units in the box to the left of the units.  Numbers may be entered with 
decimals or fractions. 

Pick Distance may be used when the scale of the drawing is not known, or when a graphic 
scale is included on the drawing.  After clicking on the Pick Distance button, select two points 
in the drawing that are a known distance apart.  These might be two points on a graphic scale 
or two endpoints of a dimension string – anything that has a reliable measurement associated 
with it.  Setting some point snaps before picking the distance will help you make an accurate 
selection. 

 
  

When picking a distance in a raster 
image where point snaps are not 
available, try to select as long a 
distance as possible, and zoom in on 
the points to get as good a 
measurement as you can.  This will 
reduce the error. 

Then set the Display Units 
Again, choose the units of measure first (feet, inches, cm, etc.) and then enter the number of 
these units in the box to the left of the units.  Numbers may be entered with decimals or 
fractions. 

 

 

Making unit conversions 
The LineScale plug-in can also perform unit conversions.  For instance, a drawing plotted to a 
metric scale such as 1 cm = 1 m can be converted so that distances are displayed in feet and 
inches when measurements are made. 

• First enter the Drawing Units and Display Units for the drawing as described above.  For 
our Metric to English example, the Drawing Units would be set to 1 cm and the Display 
Units to 1 m.  

• Now click on the Apply button.  This is important so that the units will be saved and 
correctly converted. 

• After saving these units, select a different unit of measure in the Display Units window.  
For our example, we would select Feet from the drop-down list.  The number in the 
Display Units box will automatically change.  Click the OK button and proceed with 
measuring.   
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Snap points 
One of the most powerful features of the LineScale plug-in is its ability to detect and “snap” to 
the underlying geometry of a vector-based PDF file.  This feature allows precision 
measurements to be taken from CAD drawings, maps, and other documents that use vector 
graphics. 

When snaps are turned on, the cursor will be displayed as a crosshair with a box in the center 
(called the selection box).  When the cursor is moved over a vector graphic image and a snap 
point falls within the selection box boundary, the cursor “jumps” to center itself on the snap 
point and it changes color to indicate that a snap point has been found. 

The available snap point settings and their associated cursor colors are: 

 

Endpoint 
The endpoint of a line or line segment (each corner of a box is an endpoint, for 
instance, as is the end of a simple line) 

Intersection 
The point at which two lines cross or meet.  Each corner of a box is an intersection, 
as is the center of an X shape. 

Perpendicular 
A point on a line that defines a perpendicular between the line and the last point 
picked.  Hard to describe but easy to use once you try it! 

Center 
The center of a circle or circular arc.   
 

Midpoint 
The midpoint of a line or line segment. 
 

None 
Point snapping is disabled. 
 
 

 

Note that some CAD software and 
other graphics programs plot circles as 
many-sided polygons.  The Center 
snap setting will not be able to locate 
the center of these polygons.  Only 
circles drawn as true arcs will be 
detected properly by this setting. 
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Setting default snap points 
The Settings dialog box contains a check box for each type of snap.  Selecting snaps here will 
define them as “default” snaps to be used in all measurements until they are changed again in 
the Settings dialog. 

If no boxes are checked then snapping will be disabled and the cursor will be displayed as a 
crosshair with no selection box. 

 
Override snaps 
The right-click menu provides a way to temporarily “override” the default snap point settings 
until the next point is picked.  For instance, if Endpoint and Intersection snaps are set as 
defaults and the right-click menu is used to choose Midpoint, then only Midpoint snap will be 
enabled until the mouse is clicked on a point.  Then the default snaps will go back into effect. 

This feature is useful in complex drawings where there may be many potential snap points in 
one area and multiple default snaps may be in effect.  The override snap allows you to 
temporarily disable the unwanted snaps and focus only on the one that is needed. 

Selecting None from the override snap menu will temporarily turn off all snaps and will allow 
you to select a point very close to a snap point without having the cursor jump over to the snap 
point. 

Override snaps can be used any time LineScale is active – when beginning a new measurement, 
or in the middle of a multi-segment measuring operation. 

 

Availability of snap points 
Snap points can only be detected in vector graphics.  Vector graphic drawings are usually made 
by creating a PDF directly from CAD or illustration software using a PDF printer driver.   

Text or scanned images (including scans of floor plans or other line drawings) cannot be 
analyzed by LineScale to locate snap points.  All the other features of LineScale will still be 
usable, but the accuracy of measurements will depend on how precisely you can position the 
cursor on the drawing.  Try zooming in to select points as accurately as possible, and turn off 
point snapping to get a simple crosshair cursor, which should help with alignment. 

 

 

The right-click override menu may be 
used in the middle of a LineScale 
measuring operation.   

For instance, you can select one point 
using the default snap settings, then 
right-click and choose an override snap 
setting for the next point to be 
selected. 
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The selection box 
The Settings dialog box includes a slider control to vary the size of the selection box on the snap 
cursor.  As the cursor is moved around the screen, any snap points that fall within the selection 
box will cause the cursor to jump to the point and change color.   

A larger box will make it easier to snap to points (the cursor will not have to be moved as 
precisely in order to find a snap point) but it may also cause difficulty on complex drawings 
where many lines are close together.  Sometimes more than one potential snap point may end 
up inside the selection box, in which case only the first point found by LineScale will be used.  
Making the selection box smaller will alleviate this problem.  

Experiment with this setting to find the best balance between ease of selection and precision for 
the type of drawings you are measuring. 

 
Optimizing performance with point snaps 
When point snaps are used in large drawings with many lines, there may be a slight delay as 
LineScale locates snap points.  This delay is a result of the extra processing that is required for 
calculation of point locations. 

To get the best performance when using point snaps, try the following: 

• Limit the number of default snaps to only those that are really needed.  Usually 
endpoint snap is the most often used – try setting it as the only default, and when you 
need another snap, use the right-click override menu. 

• Zoom in to the section of the drawing where you are making measurements.  This will 
reduce the number of lines that LineScale has to evaluate in order to find snap points. 

On some older computer systems with slower processors and limited memory, it may be best to 
turn off all default snaps and use override snaps (from the right-click menu) only they are really 
needed.  

Most CAD systems plot lines to a PDF 
file as a true line with a specific 
thickness.  This is good, because it 
means that snaps will work correctly 
and unambiguously. 

In some instances, though, a line may 
be drawn as a thin, filled rectangle.  
This commonly occurs with “polylines” 
plotted from AutoCAD.  You can’t see 
the difference on the screen, but when 
you try to snap to the endpoint of this 
type of line, you will really be snapping 
to one of the corners of a rectangle. 

This may produce a slight inaccuracy 
when repeated measurements are 
made, because it will be difficult to 
know which corner of the rectangle is 
being chosen as the snap point. 

To be sure, zoom in close and snap to 
the endpoint of the line.  If the snap 
cursor is in the middle of the endpoint, 
then it is a true line.  If the snap 
appears at the corner, then the line 
has been drawn as a rectangle. 
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You may change the view displayed in the document window in the middle of a measuring 
operation, without interrupting the measurement in progress. 

This feature allows you to zoom in close to one area of the drawing, select a point, and then 
zoom or pan to another area for selection of another point.  
 

Changing views with the Viewing toolbar or the scrollbars 
When a LineScale measurement is in progress, selecting any of the following view change tools 
will result in an immediate change in view, after which the measurement will resume 
automatically: 

• Any of the tools in the Viewing toolbar: 
 

 
 

• Any of the commands in the View menu 

• Either of the scrollbars 

 

 

Changing views with zoom windows or the hand tool 
A different procedure is needed for changing the view with any of the view tools in the Basic 
toolbar as shown below: 
 

 

 
After the hand tool or either of the magnifier tools (a window zoom) is used, the LineScale tool 
will need to be re-selected.  The measurement that was in progress before the view change was 
made will be resumed. 

Remember, to cancel the current measurement in progress, hit the ESC key. 
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Some commonly-encountered problems, and solutions for dealing with them, are outlined below.  For other problems, check the Support page. 

 

Problem Cause Solution 

The LineScale plug-in tool icon does not 
appear in the toolbar 

There is an Acrobat setting to allow only plug-
ins “certified” by Adobe to be loaded.  
LineScale is not certified and will be blocked if 
this option is set. 

• Go to Edit > Preferences > General 

• Un-check the Certified Plug-ins Only 
box. 

• Exit and restart Acrobat 

 The toolbar containing the LineScale icon is 
not currently displayed.  The LineScale tool is 
located in the Basic Tools toolbar, and if this 
is set to be hidden, then none of the tools 
associated with it will be shown.  

• Position the mouse over any toolbar 

• Right-click 

• Choose Basic Tools from the menu 

A dialog box appears saying that the plug-in is 
not compatible with my version of Acrobat 

The LineScale plug-in works with version 7 or 
higher of Acrobat 

Click here to purchase Acrobat. 

A dialog box appears saying that the 
evaluation period has expired.  

If you have been using the plug-in in 
evaluation mode, this means that the trial 
license (which is limited to three days) has 
expired. 

Purchase a license by clicking on the Buy 
Now! button in the dialog box. 

 If you have already purchased and installed a 
license key, it may have become corrupted, 
especially if you have rebuilt or edited your 
system registry.   

Click on the Enter key button in the dialog 
box, and re-enter the key that was sent to you 
via email when you purchased it. 

http://www.adobe.com/products/acrobat/main.html
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Problem Cause Solution 

When the license key is entered, an error box 
comes up saying “The name/key you entered 
does not appear to be valid. Please try again.” 

Some part of the key was entered incorrectly. 
The key has two parts – the name and the key 
code.  Both parts must be entered exactly as 
they are shown in the email message that was 
sent containing the key.   

• Locate the email message containing the 
key 

• Select the name portion of the key 

• Choose Copy from the right-click menu 

• Click on the Name field in the Registration 
dialog box 

• Choose Paste from the right-click menu 

• Repeat above steps for the key code 
portion of the key 

 The key was generated incorrectly or 
corrupted while being sent. 

Contact info@linetype.com to obtain a new 
key. 

Measurements are coming out very wrong The scale is incorrect Check the settings for Drawing Units and 
Display Units in the Settings dialog box. 

Measurements are slightly different than 
dimension strings on the drawing – and I am 
sure the scale is correct! 

This is probably due to differences in the way 
rounding is performed by LineScale and by the 
CAD application that generated the drawing 
(and the dimension strings). 

LineScale will round up any distances that fall 
in the middle of the display precision range.  
For instance, 1/16” will be rounded to 1/8” if 
display precision is set to 1/8”. 

The CAD application that generated the 
dimensions may be rounding down, which 
would account for the slight discrepancy. 

Increase display precision in the Settings 
dialog box.  This will give you a better idea of 
the “actual” unrounded distance. 

Contact the person who generated the CAD 
drawing to determine how rounding variables 
were set for dimension strings. 

mailto:info@linetype.com
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Problem Cause Solution 

The cursor will only move horizontally or 
vertically. 

Ortho lock is turned on and needs to be turned 
off.  Ortho lock is controlled by the Shift and 
Caps Lock keys. 

Make sure that the Caps Lock key is not 
active.  Usually a light on the keyboard will 
indicate if Caps Lock is on. 

There are extra red lines drawn on the screen 
when the display is scrolled.  And sometimes 
stray red lines are left on the screen when ESC 
is hit. 

If the scrollbars are used during a 
measurement this will happen on some 
systems.  The solution is to include some extra 
screen refreshes during scrolling – but this 
slows down performance.  So only do this if it 
is really necessary. 

Check the Redraw screen when scrolling 
box in the Settings dialog box. 

Lines on the screen look uneven and too 
heavy 

This is not a problem with LineScale, but 
rather has to do with how Acrobat displays 
vector graphics.  Turning on vector graphic 
smoothing will improve appearance but may 
affect display performance. 

• Go to Edit > Preferences > General 

• Click on the Display item in the list on the 
left side of the dialog box. 

• Check the Smooth Line Art box 

• Click OK to exit the dialog box 
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Free email support is available to all users, and we welcome reports of problems or suggestions for improvement. 

Support email address is info@linetype.com or visit the LineType Software, Inc. website at www.linetype.com  

 

For more information about the PDF format and about generating PDF files from CAD software or other graphics applications, visit 
www.linetype.com/advice  

 

Thank you for using the LineScale plug-in! 

 

mailto:info@linetype.com
http://www.linetype.com/
http://www.linetype.com/advice
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